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1 Introduction

These release notes highlight new functionality, enhancements, software and hardware dependencies, and
include upgrade instructions for UC Server (all editions). This document is to be used in conjunction with product
documentation and training for the preparation of new and existing software installations and is intended for
Objectworld Technical Professionals who are providing support services for UC Server. For information on how to
become an Objectworld Technical Professional see section 7.2, Training.

For general product information please visit our Web site at http://www.objectworld.com/.

WARNING: It is strongly recommended that the contents of this document be
reviewed before any installation or upgrade, no matter how familiar the
installer may be with the product, to ensure that current installation and
upgrade procedures are followed. These procedures may change from release
to release, including maintenance releases. Failure to follow the upgrade
procedures in this document may result in non-operational systems.

Ll

2 Summary of Changes

This section describes a summary of new functionality introduced in this UC Server release, along with issues
resolved in each release and any release-specific actions that are required as part of upgrading. Each maintenance
or “dot” release is identified separately. More detailed descriptions for major new functionality follow in section 3,
New Functionality Details. Internal tracking numbers are noted (e.g. [1234]).

For newly introduced functionality and issues resolved in previous major releases, please consult the release notes
or product documentation for the respective releases.

Where functionality or issues resolved do not apply to all editions, the applicable additions are noted (e.g.
CEBP).

Note: Be sure to review all upgrade actions for all releases between your current release and the release you are
upgrading to. Sub-sections in the sections below identify required actions, including information about client
upgrades.

2.1 Release 4.4.3

Release 4.4.3 is a maintenance release that resolves issues identified in Release 4.4.2 and also provides BLF
support on snom phones, Connect+ support for some Aastra and Polycom Kirk Wireless Server devices, as well as
firmware updates for some Aastra phones.

2.2.12  New Functionality

The new functionality included in this release includes:

e  BLF support on snom phones. See section 3.6 for more details. [8361]
. 3rd Party Compatibility Additions and Upgrades
o Support for Dialogic SR 6.0 SU 229, supporting Windows Server 2008 [8295]
o Telephone terminal support for:
»  Connect+ support for Aastra 6756i CT, 9143i, 9480i, and 9480i CT [8380]
= Connect+ support for Aastra 6730i and 6731i [8311]
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= Connect+ support for Polycom Kirk Wireless Servers (KWS300, KWS6000) and
associated handsets [8304,8305]
= Connect support for Polycom Spectralink 8002 [8310]
o Telephone terminal firmware updates: SIP, CEBP
= Aastra 675xi series (6751i, 6753i, 6755i and 6757i): v2.5.1 [8380]
=  Aastra 675xi: v2.5.0 [8306]

2.1.2 lIssues Resolved

Tracking# Summary

6078 Fax Receive service not invoked for attendant services on admin profile.

8291 Aastra 6730i and 6731i default configurations did not have support for multi-cast paging enabled.
SIP, CEBP

8336 When e-mail notifications are enabled for a user, and the user has a large number of e-mails in
their Inbox (>10000), then the Application Server can restart due to delays accessing Exchange
Server mailbox data. With this change, e-mail notifications will no longer include counts related to
the number of e-mails if the mailbox summary option is set to “Quick” (and thus doesn't indicate
the number of new e-mails over the TUI).

8338 Default snom configuration did not allow access to web Ul. |SIP, CEBP

8351 Server install pre-requisite installer incorrectly wants to install Enhanced Desktop feature when
installing on Windows 7. Windows 7 is not yet officially supported in this release.

8352 Auto-answer for SIP paging does not always work after clean install or after phones re-register.
SIP, CEBP

8354 Microsoft SQL Server 2005 Express Edition SP3 required to install server components on Windows
7 or Windows Server 2008 R2. Windows 7 and Windows Server 2008 R2 are not yet officially
supported in this release.

8358 In some circumstances, the Application Server restarts while modify user mailbox settings.

8363 Long calls may be dropped while processing a re-INVITE. |SIP, CEBP|

8367 SIP Paging service does not start when Event Viewer log is full. |SIP, CEBP

8375 snom configuration files missing user outbound parameter not allowing users to return calls
from the call history. [SIP, CEBP|

8378 Polycom call recording technical note (TN114) update to correct minor issues. |SIP, CEBP

8383 Vegastream integration documentation updated to include correct configuration for calls with
hyphens in the caller name information. |SIP, CEBP

8409 Incorrect audio played in some circumstances when using data sources that allow selection of a
number of rows containing audio.

8414 Printing not working in various user interface components where it previously had worked.

8423 Application Server restarts when sending messages to large distribution lists where large numbers
of users have e-mail notification options enabled.

8424 PowerShell Set-UcAuthentication command does not change the password when using the

NewPassword parameter.
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Tracking# Summary

8436 Polycom phones do not display Join and Split soft keys required for on-phone conferencing
capabilities. |SIP, CEBP

8437 After completing a transfer for an external caller, the caller’s number is displayed incorrectly in
ucCompanion — Live Attendant. [SIP, CEBP|

8441 Send E-mail element configured as “Custom” does not send audio file attachments to recipients

other than the first recipient.

8458 Dial-by-name error path results in incorrect prompt being played to caller.

2.1.3 Client Upgrade Actions
In general, client software does not need to be upgraded for this release. The following exceptions apply:

e For administrators experiencing resolved issue [84247, client software MUST be upgraded to obtain the
issue resolution.

2.1.4 Other Upgrade Actions

No additional actions are required beyond those listed for other maintenance releases.

Additional instructions have been provided to supplement product documentation related to Exchange Server
2003 integration. Please see section 4.2.2, Mail/Messaging Servers for Unified Messaging, for more details.
2.2 Release 4.4.2

Release 4.4.2 is a maintenance release that resolves issues identified in Release 4.4.1 and also provides Windows
PowerShell support for administering users, identities, phones and authentications from the command line.

WARNING: Outlook 2007 SP2 (recently released) is not compatible as a server
MAPI connector with UC Server and installing it will cause UC Server to be
unable to connect to Exchange Server. Please see section 4.2.2,
Mail/Messaging Servers for Unified Messaging, for more details.

Ll

2.2.1  New Functionality
The new functionality included in this release includes:

e  Support for administering user related objects using Windows PowerShell vi.0. Please see section 3.5,
Windows PowerShell Snap-In, for more information. [8300]

2.2.2 Issues Resolved

Tracking# Summary

6414 In some circumstances, the server install “boot strapper” would remain on the “Install UC Server”
page after installation. Instead, it should have requested a system restart to complete installation
of files that were in use at the time of install or upgrade.
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Tracking# Summary

8243 In some circumstances, UC Server caller information properties are not retained by Exchange
Server and caller hears “unknown caller” when caller information was available on the call.
Workaround uses caller information stored in the message subject to determine caller information
if the special message property is absent. [Previously addressed, however, new circumstance was
discovered and corrected under same tracking number.]

8297 EyeBeam would not receive calls immediately after re-registering. Problem was intermittent and
timing related and may not always have occurred. |SIP, CEBP|

8307 Polycom call recording soft keys cause ending a call or transferring a call to be awkward. Call
recording soft keys have been moved to later in soft key list to keep more commonly used keys
accessible. |SIP, CEBP

8308 When playing back a message where caller information was not available, silence or “clicks” may
be heard instead of “an unknown caller”.

8318 UC Client could be installed over top of UC Server, causing upgrade problems and difficulty
removing the client. Warnings have been added to installer, along with directly preventing
installing UC Client into the same folder as the server software.

8320 Pre- and Post- Update scripts failing on 64-bit platforms.|SIP, CEBP|

8323 Server may require a reboot after upgrading if services not manually stopped before upgrade.

8327 Unable to reply to message or call back caller of message if caller information properties are not
retained by Exchange Server. Caller is told that no phone number is available.

8328 In some circumstances, Outlook voice and fax forms crash when compositing To, CC, and BCC lists
during a forward.

8331 PBX database upgrade script fails to correctly modify a table causing SIP peering to not function.
This only affects systems upgraded to 4.4.1. Installing 4.4.2 or later will correct the database table.

8332 Uninstall prompts to manually close services that it is removing.

2.2.3 Client Upgrade Actions

In general, client software does not need to be upgraded for this release. The following exceptions apply:

e If system administrators want to be able to remotely administer UC Server using Windows PowerShell
v1.0, the client software MUST be upgraded. After upgrading the client software, the PowerShell Snap-In
feature of UC Client must be installed using the Programs and Features (or Add/Remove Programs)
control panel for it to become available. Please see section 3.5, Windows PowerShell Snap-In, for more
information.

2.2.4 Other Upgrade Actions

Objectworld now recommends the use of the most recent release of Microsoft Exchange Server MAPI Client and

Collaboration Data Objects 1.2.1 instead of Microsoft Outlook and encourages all customers to switch to this

MAPI connector instead of Outlook on the server system. This does not apply to client systems. Please see section

4.2.2, Mail/Messaging Servers for Unified Messaging, for more details.
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Release 4.4.1

Release 4.4.1 is a maintenance release that resolves issues identified in Release 4.4.0 and provides additional SIP

telephone support, including Connect+ support for current Aastra 675xi series phones, Connect support for

Polycom Kirk Wireless Servers and Interoperable support for Atlas Sound paging devices.

2.3.1

New Functionality

The new functionality introduced in this release includes:

2.3.2

3rd Party Compatibility Additions and Upgrades
o Telephone terminal support for: SIP, CEBP
= Connect+ support for Aastra 675xi series (6751i, 6753i, 6755i and 6757i) [5286]
= Connect+ support for snom 820 [8183]
= Connect+ support for Grandstream Budgetone 201 [8267]
= Connect+ support for Polycom VVX 1500 [8264]
= Connect+ support for Atlas Sound VolP Speakers (I8S, 18SC, I85CM, IHVP and 121285YS)
and VolP Zone Controllers (IPS-ZCa and IPS-ZC1) [8284]
= Connect support for Polycom Kirk Wireless Servers: KWS300, KWS600v3, KWS6000
and associated handsets (2010, 3040, 4020, 4040, 5020 and
5040)[7853,8241,8242]
o Telephone terminal firmware updates:
"  snom 300, 320,360and 370:v7.3.24 [8177]
= Aastra gxxiand 4xxi: vi.4.3 [8239]
= Polycom SoundPoint IP and SoundPoint IP (all models): v3.1.2 [8264]
Support for call recording using Polycom phones (see TN114 — Call Recording with Polycom Phones for

more information) [8279] SIP, CEBP|

Issues Resolved

Tracking# Summary

7646 Some SIP telephones will emit a beep in addition to the paging tone emitted by UC Server.

CEBP

8146 SIP services fail to reconnect to database after unmounting the database during a backup.

CEBP

8157 Calls from CISCO CME over SIP trunk to UC Server conference server may fail. | SIP, CEBP

8lel Multicast paging and auto-answer do not work on snom 370 SIP phone. |SIP, CEBP

8232 Deleting messages from the integrated messaging client takes a long time when there are a large

number of messages in the mailbox.

8234 Sent faxes failed to get delivered to “Sent Mail” folder for Google Mail (Gmail) IMAP accounts.

8238 Dialogic Media Gateway configuration documentation updated to reflect settings required to

reliably sent and receive faxes.

8243 In some circumstances, UC Server caller information properties are not retained by Exchange

Server and caller hears “unknown caller” when caller information was available on the call.
Workaround uses caller information stored in the message subject to determine caller information
if the special message property is absent.
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Tracking# Summary

8244 Inbound calls from Mediatrix gateway transferred by auto-attendant get dropped. | SIP, CEBP|

8251 Application services may restart during Active Directory synchronization if network is slow of
Active Directory server is slow to respond.

8255 Audio messages are truncated if they are terminated by silence and silence suppression is being
performed by the SIP gateway. |SIP, CEBP

8256 Performance improvement for generating message summary information over TUl when used
with large Exchange mailboxes (>10000 messages) where majority of messages are e-mail
messages.

8257 Stuttering of audio when administration client is used on server system on single core CPU.
CEBP

8277 Application server restarts if identity is deleted at the same time as a user is edited from another
administration client.

8278 Memory leak eventually causing application server restart or unrecoverable hang during prolonged
continuous server operation.

8293 Active Directory synchronization messages are emitted to the admin logs even when changes do

not occur in Active Directory.

2.3.3 Client Upgrade Actions

In general, client software does not need to be upgraded for this release. The following exceptions apply:

e If using the Windows Essential Business Server 2008 Console Plug-in, client software MUST be upgraded
on systems using the EBS Console.

e  For users experiencing resolved issue [82321, client software SHOULD be upgraded to obtain complete
benefits of the issue resolution.

2.3.4 Other Upgrade Actions

For upgrades of SIP and CEBP editions, scripts MUST be run before and after upgrading to properly upgrade

phone configuration files. Any customizations to phone configuration files and phone image files MUST be

manually re-applied using the information and backups made by the scripts. See section 5.2.2, Upgrading UC

Server from any 4.x.x Release for more information on this procedure.

2.4 Release 4.4.0

Release 4.4.0 is a major release of UC Server that introduces support for SIP paging, adds a number of service

enhancements and new service elements, provides updated firmware for both snom and Polycom phones, and

adds a Windows Essential Business Server 2008 plug-in for user management.

2.4.2  New Functionality

The new functionality introduced in this release includes:

e SIPPaging [7101] SIP, CEBP|

e Service environment improvements and new elements

New Elements
=  Generates Tones[7272]
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= Execute Program[7325]
* Queue Outdial [7292]
= Detect Remote Party [7358]
=  Wait for Silence [7367]
o Other Improvements
= Temporary audio file capability [7349]
=  Enhanced comparison methods in Compare Data element [7335]
=  Send E-mail element can attach recorded audio files [ 7351 ]
e Additional support for saving and forwarding fax messages as PDF files [ 7887, 7945, 7946]
e Windows Essential Business Server 2008 Console Plug-in [ 7838]
e  Windows Small Business Server 2008 Console alert support [ 7844 ]
e Advanced Call Queuing Enhancements:
o  Option for controlling automatic logout of agents [5445] |SIP, CEBP
o  Option for controlling overflow timeout [5447]
e  Otherimprovements:
o Administrative Ul action to resynchronize message waiting lights [6665]
3rd Party Compatibility Additions and Upgrades
o Telephone Terminal Support for:
= snom firmware updated to 7.3.7 allowing automated firmware updated to snom phones
via TFTP [7578]
*  Polycom SoundPoint IP firmware updated to 3.1.0" [7583]
= Support for Polycom SoundPoint IP 450, 560, 670 [7583]
=  Support for Polycom SoundStation 6000, 7000 [7463, 7581]
o Integration guides or technical notes have been added for the following products and services:
= TNzio1 - Quintum Survivable SIP Gateway Installation and Configuration [7315]
CEBP|
=  TN1o4 - Aastra 5xi Installation and Configuration [ 7727 ]
= TN1os - Ensuring Compatible PCl Slots for Dialogic Media Cards [ 7599]
= TN106 — Polycom Kirk Wireless Server 300 Installation and Configuration [7853]
CEBP|
=  TNio7 - Quintum Tenor AF Gateway Installation and Configuration [8051]
»  TN108 - Best Practices for Integrating UC Server with Microsoft Exchange Server

[8086]
2.4.2 lIssues Resolved
Tracking# Summary
5781 IP address changes of SIP phones located on a different subnet from the UC Server are not
registered.
7197 Dial-by-name audio prompts do not tell caller how to exit the dial-by-name process.
7274 When the client queried contacts for a user, more information than was necessary is pulled from

Microsoft Exchange Server. This has been optimized to minimize the information to only that
which is required.

7331 Corrupt archive logs cause runtime error while trying to log to UC Client in as admin.

* Older model Polycom sets, including the Polycom SoundPoint IP 301, are no longer supported with this version
of the firmware.
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Tracking# Summary
7585, 7586 Improved handling of network adapter changes to include more obvious identification in the

network adapter selection dialog and in warning logs. | SIP, CEBP

7706 With SIP phones other than Polycom, the part initiating a blind transfer must manually hang up
the call. |SIP, CEBP

7886 TNo37 and TNo6g for Quintum gateway integration did not include information on setting up
incoming caller name. |SIP, CEBP

7910 Numbers restricted by dialing restrictions are not listed in warning logs.

7923 If a user’s Active Directory association was changed, the UC Server synchronizer would revert the
association to the previous user.

7937 “Last Unique ID” should be allowed In field assignment in Add Data and Update Data elements.

7957 CODECs presented during music on hold did not reflect the ability of the music-on-hold service’s
ability to stream audio in the presented formats. |SIP, CEBP|

7970 Application server could restart when a user’s client was open with Integrated Messaging, and the
administrator changes their message store to Exchange Server and a new message arrives and the
user tries to move the message to a new folder.

7999 Music on hold is not provided when Polycom sets are set to only use G.722 CODEC. |SIP, CEBP

8045 Systems not licensed for TTS would issue a warning notification if users did not have mailbox
identifiers recorded.

8069 CODEC negotiation would fail using CBeyond when calls directed to conference bridge.
CEBP

8075 Grandstream GXP 1200 phones do not attempt to re-register for 1 hour if registration fails.
CEBP

8092 IP addresses associated with phones on different subnets from UC Server are not maintained after
initial detection of the phone. [SIP, CEBP

8096 When skipping to the end of a message within the last 3 seconds of the message, no prompt would
be heard for the end-of-message menu. (Affected SIP-based integrations only)

8112 Memory allocation would fail while querying network adapters causing application server to
restart. |SIP, CEBP

8125 Inter-digit timeout for “directory assistance” within mailbox management was not long enough.
Timeouts have been increased to 5 seconds between digits and 7,5 seconds for the first digit.
Additional, other digit related timeouts have been increased slightly from 1.25 seconds to 2.5
seconds.

8126 Faxes sent over noisy lines using T.38 would fail when error correction took place or when page
was longer than one 255 T.30 frames.

8127 Users “disappear”: Additional recovery, diagnostics and administrator notifications have been
added to mitigate and diagnose related issues.

8144 ACQ agent does not receive call as agent appears to be “stuck on a call”.
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Tracking# Summary

8208 Fax transmission results report “Unspecified error” when destination line is busy when using SIP
gateways.

8215 snom configuration templates had unnecessary configuration attributes causing users to be unable
to modify the ringer type.

8216 Connect delay for outgoing SIP calls capped at 20 seconds causing fax connection failures.

8218 Unable to enter single digit as operator destination for per-user operators.

8222 TTS would not read e-mail messages when playing back more than one e-mail when mailbox
management occurs as a result of outgoing Active Message Delivery (AMD) call.

8224 Early releases of 4.4.0 did not allow Polcom phones to persist their audio settings. [SIP, CEBP

8228 TFTP service leaves sockets open longer than necessary after file requests are complete,

potentially leading to shortage of resources. [SIP, CEBP

Note that all fixes included in 4.3.1, 4.3.2, 4.3.3, 4.3.4 and 4.3.5 are included in release 4.4.0. Please consult the
release notes for 4.3.5 for details on issues resolved in those releases.

2.4.3 Upgrade Requirements

Prior to upgrading an existing UC Server system, be sure that the hardware platform and operating system

software meet the minimum requirements; otherwise, you will not be able to upgrade the software. Ensure that

both client and server requirements are met. See section 4.2, System Requirements for more information.

2.4.4 Client Upgrade Actions

Client software MUST be upgraded for all users of the UC Server system. More information on client deployment

techniques, including automated deployment can be found in section 5.3, Installing or Upgrading UC Client

Software.

2.4.5 Other Upgrade Actions

For upgrades of SIP and CEBP editions, scripts MUST be run before and after upgrading to properly upgrade

phone configuration files. Any customizations to phone configuration files must be manually re-applied using the

information and backups made by the scripts. See section 5.2.2, Upgrading UC Server from any 4.x.x Release for

more information on this procedure.

RestartOverrides.cfg MUST be updated on the UC Server to include updated settings provided in

RestartOverrides.cfg.original.

WARNING: Backup procedures have changed from releases prior to 4.3.3. The
UC Server SQL database instance MUST be backed up for ALL editions and
installations to ensure proper recovery of failed systems. Please review TNo66
- Backup and Restore Procedures and adjust backup procedures accordingly.
Failure to do so may result in data loss or extended system outages in the case
of hardware or software failures.

o
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WARNING: Due to fixes related to MWI behavioral inconsistencies introduced

in release 4.3.1, when a system is upgraded to 4.4.x from a release prior to
4.3.1, Users's may experience a change in behavior of the MWI if their
preferences (or system-wide settings) for MWI behavior are not set as they
would prefer. Please ensure that system defaults are correctly set and that
users are aware of how to change their MWI preferences.

o

3 New Functionality Details
This section describes more significant portions of the new functionality introduced in this UC Server release.

Where functionality does not apply to all editions, the applicable additions are noted (e.g. ).

3.1 SIP Paging

UC Server SIP Paging and public address systems are supported in UC Server SIP and CEBP Editions. SIP Paging
includes the creation of paging groups (paging zones) which include simultaneous support for SIP Phones and IP
Multicast IP addresses. UC Server will support any combination of Connect+ SIP Phones and supported overhead
SIP Paging Speakers, SIP Paging Gateways, and SIP Zone controllers.

SIP Paging can be accessed by directly dialing the paging service feature access code followed by a configured
paging group identifier. SIP Paging is also integrated as part of the service environment. Two new elements (Page
Live and Page Recorded) elements are introduced that allow for paging control through a service. The flexibility of
the service environment allow for service rule creation for sophisticated paging applications that rely on time-of-
day, calling / called number validation or database enabled applications. The Page Live element will transfer the
caller to a paging service so that the caller can speak directly to a zone selected in the service. The Page Recorded
element will allow callers to review the audio prior to queuing the page to be played to the selected paging group.

Additional licenses are required to be purchased to enable multicast IP addresses, or adding unicast paging
members beyond the number of SIP users in a system.

3.2 Service Environment Improvements and New Elements

This version of UC Server improves the service environment to include enhanced capability for Value Added
Resellers to created applications for inbound and outbound call campaigns. UC Server now includes the ability to
distinguish between live answered calls and answering machines — which allow UC Server to deliver notifications
and reminders with the ability to interact with callers or leave messages on answering machines.

UC Server now has the ability to execute programs from within the service environment allowing Objectworld
Value Added Resellers to create line of business middleware applications that can be used with UC Server’s
inbound and outbound call services.

Applications enabled with the new functionality include, but are not limited to:

*  Electronic control systems
= Outbound dialers that differentiate between humans and answering machines
* Integration with third party applications

The following new elements (not including the SIP Paging elements) have been added:

=  Generates Tones
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=  Execute Program

*  Queue Outdial

= Detect Remote Party
= Wait for Silence

In addition, the following improvements have also been made:

=  Temporary audio file capability
* Enhanced comparison methods in Compare Date element
» Send E-mail element can attach recorded audio files

3.3 Windows Essential Business Server 2008 Console Plug-in

UC Server now provides a Windows Essential Business Server 2008 Console Plug-in that is installed as part of the
UC Client install. This plug-in enables system administrators to administer UC Server users directly from within
the Windows Essential Business Server 2008 Console.

3.4 Windows Small Business Server 2008 Console Alert Support

UC Server now provides notifications of warnings and alerts within the Windows Small Business Server 2008
Console. Alerts are raised when either an error or a warning occurs in UC Server, and are cleared when the
administrator acknowledges or clears the warnings in the logs.

3.5  Windows PowerShell Snap-In

UC Server now provides support for a Windows PowerShell snap-in that allows management of users, identities
(extensions), phones and authentications. This allows IT administrators to more easily integrate external systems
such that those systems can affect changes to these objects in UC Server. Additionally, the advanced scripting
functionality of Windows PowerShell allows IT administrators to easily export, import, migrate and otherwise
make bulk changes to user related data on UC Server.

Windows PowerShell vi.0 needs to be installed on the relevant computer system before upgrading or installing
the UC Client or UC Server feature. It can be downloaded from Microsoft from the following location:
http://www.microsoft.com/windowsserver2o003/technologies/management/powershell/download.mspx.

The Windows PowerShell snap-in is installed as feature of the client components (disabled by default) and as a
feature of the server components (enabled by default). After upgrading either the client or server, use Programs
and Features (Vista, Server 2008) or Add/Remove Programs (XP, Server 2003) to modify the UC Client or UC
Server installed program to install the PowerShell snap-in feature on the system. Once installed, a new shortcut
appears in the Start | Programs menu, UC Server Management Shell. Launching this shortcut will open a Windows
PowerShell session with the UC Server snap-in loaded.

More general information on using Windows PowerShell can be obtained from:
http://www.microsoft.com/powershell.

More getting started information related to using Windows PowerShell with UC Server is provided when you
launch the UC Server Management Shell. Each command provides help information and examples of potential
usage. In release 4.4.2, the documentation is not yet 100% complete, but will be updated in subsequent releases.
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3.6 BLF Support on snom Phones

UC Server SIP and CEBP Editions now provide support for Busy Lamp Fields (BLF) on snom phones. Other devices
that correctly implement RFC 4235 from a monitoring and being monitored perspective may also work, but have
not been tested or certified to work correctly. In addition to snom phones being supported, snom phones may
also monitor (i.e. show a BLF) for an identity on a Polycom phone; showing a BLF on a Polycom phone is not
supported.

To enable a BLF on the snom phones, configure an available function key on the snom phone using the web user
interface. Use either the “Extension” or the “"BLF” modes. Refer to snom documentation for more information
(http://wiki.snom.com/Web_Interface/Vz/Function_Keys#Free Function_Keys).

4 Installation Requirements

This section describes the environmental prerequisites required for the correct operation of UC Server, including
operating systems, server/client platforms, messaging servers, and mail clients. In addition, it describes any
required steps that need to take place prior to installing UC Server software, including obtaining the license key.

4.1 Preserving Installation and Upgrade Media

If physical installation media (a CD or DVD) was received, please store this media in a safe place so that the
software may be reinstalled at a later date should that be necessary (for example, in the event of a hardware
failure).

If the software was downloaded, please ensure that a separate copy of the installation media is made to CD or
DVD and this media is stored in a safe place so that the software may be reinstalled at a later date should that be
necessary (for example, in the event of a hardware failure). Do not store the downloaded media on the same
physical disks as the operational server as a single disk failure may cause this media to be permanently lost.

Ensure that if software upgrades are performed, new versions are also stored on separate media in a safe place.
Support personal may require a copy of the installation media to reinstall software at a later date.

WARNING: Failure to preserve installed software release media properly may

result in the inability to rebuild a failed server at a later date. Copies of non-
current software versions may not be readily available from Objectworld
Technical Support or your reseller and thus delays may be incurred if this
media is not available to support technicians rebuilding failed servers.

4.2 System Requirements

4.2.1  Server Components

This section describes the required operating systems, hardware requirements and third-party integration
platforms for the server components of UC Server. This applies to both upgrades and new installations. If existing
server hardware does not meet these requirements, it must be upgraded or migrated to new hardware prior to
upgrading to this release of UC Server.
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4.2.1.1  Operating Systems
The server components of UC Server support the following Microsoft® Windows™ Operating Systems:

e  Microsoft® Windows Small Business Server 2008 (x64)

The recommended deployment for optimal performance and reliability is to install UC Server on the
additional Windows Server 2008 license that is part of the Premium Edition of Windows Small
Business Server 2008. UC Server can also be installed on the Windows Small Business Server 2008
platform with suitable hardware. See section 4.2.1.2, Hardware Requirements, for more information.

e  Microsoft® Windows Essential Business Server 2008 (x86, x64)

UC Server should be deployed on the additional Window Server 2008 license that is part of the
Premium Edition of Windows Essential Business Server. Do not install UC Server on the Security
Server. It is not recommended to install UC Server on either the Management Server or the
Messaging Server.

e  Microsoft® Windows™ Server 2008 (x86, x64)
o Foundation, Standard, Enterprise, and Data Center editions are supported.
o Deployment on Server Core or Hyper-V is not supported.
e  Microsoft® Windows™ Server 2003 R2 SP1, SP2 (x86)
e  Microsoft® Windows™ Server 2003 SP1, SP2 (x86)
e  Microsoft® Windows™ Small Business Server 2003 SP1 (x86)
e  Microsoft® Windows™ XP SP2, SP3 (Professional) (x86) (Warning: see known limitation [82821])

Other software platforms are not supported.

Installation of the server components into a virtualization environment (Virtual Server, Hyper-V, Virtual PC,
VMware, Virtual Box, etc.) is not supported in production deployments. This is due to the real-time nature of
telecommunications — audio problems will be experienced in these environments.

Objectworld recommends using a server operating system for all installations of UC Server. While the client
platforms mentioned above (such as Microsoft® Windows™ XP) are supported, they are designed by Microsoft for
desktop use not server use. Known limitation [8282] is also known to affect the reliability of Windows XP
installations and may cause system outages in certain circumstances. See section 9, Known Software Limitations
for more details.

WARNING: At this point in time, many third-party drivers and applications
may not yet support Windows Server 2008 and derived platforms (SBS 2008,
EBS 2008). When using TAPI integrations, or other integrations requiring use
of CTl drivers, please review driver documentation for those products BEFORE
proceeding with plans to use Windows Server 2008 as the server platform for
those deployments.

o

4.2.1.2 Hardware Requirements

To install UC Server, the server hardware platform must meet the minimum requirements in the table below. The
minimum requirements are for a minimal installation. The recommended requirements are a guideline for more
robust, reliable and “future-proofed” systems.

Product engineering guidelines and recommendations should be consulted and followed for anything other than a
minimal installation (i.e. installations with more than 25 users). Sizing of the server hardware is dependent on the
number of users, the traffic levels and application services used. Selection of hardware should also take into
account such things as redundant power supplies, uninterruptable power supplies (UPS) and redundant disk
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arrays (i.e. RAID) such that the end-users needs and expectations are met, along with any future growth
requirements.

Consult TN102 - Hardware Platform Recommendations and the Planning and Deployment Guide for more
information on correctly selecting the hardware.

Hardware Minimum Recommended
Component
Processor Intel Pentium Dual-Core (E2140) Intel Xeon Quad-Core (E5310)
RAM 2GB 4 GB
4 GB on Windows Small Business Server 2003 6 GB on Windows Small Business Server 2008

6 GB on Windows Small Business Server 2008

Disk space 80 GB (usable space) 146 GB (usable space)
7200 RPM SAS —-RAID 1 0r RAID 5

4.2.2  Mail/Messaging Servers for Unified Messaging
UC Server supports the following e-mail servers for Unified Messaging:

e  Microsoft® Exchange™ Server 2000, 2003 SP1*, 2007

e IBM® Domino™ Server 6.0.%, 6.5.%, 7.0, 8.0 (via IMAP)

e Google Mail (via IMAP using stunnel)

e  University of Washington IMAPd

e Any100% compliant IMAP4revi (RFC3501) message store (different servers may require different query
optimization techniques — consult product documentation for query optimization technique
determination procedures)

* Requires service pack 1 or later.

Integration with Microsoft® Exchange™ Server requires a MAPI connector to be installed on the UC Server
platform. The supported MAPI connectors, of which only one should be installed on the server platform, are the
following:

e  Microsoft Exchange Server MAPI Client and Collaboration Data Objects 1.2.1
[Version: 6.5.8069.0, 2009-Feb-16 — older versions are not be compatible with all platforms]
This is available for download free of charge from:
http://www.microsoft.com/downloads/details.aspx?familyid=e17e7f31-079a-43a9-bff2-
0a110307611e&displaylang=en

e  Microsoft® Outlook™ 2003 SP3

WARNING: Failure to use SP3 with Microsoft® Outlook™ 2003 will cause
i unreliability of the integration with Microsoft® Exchange™ Server and may
cause system outages.

£l

e  Microsoft® Outlook™ 2007 SP1 (SP2 is not Supported)

WARNING: Outlook 2007 SP2 (recently released) is not compatible as a server
) MAPI connector with UC Server and installing it will cause UC Server to be
unable to connect to Exchange Server.

\.-
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Objectworld now recommends the use of Microsoft Exchange Server MAPI Client and Collaboration Data Objects
1.2.1 instead of Microsoft Outlook and strongly encourages all customers to switch to this MAPI connector instead
of Outlook. The benefits of doing this are as follows:

e No Outlook license is required for the UC Server system. The MAPI/CDO package is available at no
charge.

e The MAPI/CDO package is a minimal installation that requires fewer Microsoft Updates.

e This component is designed and provided by Microsoft explicitly for the purpose of allowing applications
such as UC Server to access Exchange Server and does not include many of the client-side nuances of
Outlook versions of MAPI.

On Exchange Server 2003, additional steps are required after following the manual integration instructions in
Appendix A of the Server Configuration Guide:

Delegate “Exchange View Only Administrators” control to the UC Server service account:

1. Open Exchange System Manager on an Exchange Server in the enterprise, or an administrative workstation.

2. Select the enterprise level object (the root object in the tree).

3. Select Delegate control... from the Action menu. This will open the Exchange Administration Delegation
Wizard.

4. Click Next.

5. Inthe Users or Groups page of the wizard, click Add to open the Delegate Control dialog.

6. Select the role Exchange View Only Administrators from the list of roles.

7. Click Browse... and select the service account used by UC Server for Exchange Server and network

integration.
8. Click OK in the Select Users, Computers or Groups dialog.
9. Click OKinthe Delegate Control dialog.
10. Click Next in the Users or Groups page of the Exchange Administration Delegation Wizard.
11. Click Finish to complete and close the wizard.

4.2.3  Client Components

This section describes the required operating systems and hardware requirements for the client components of
UC Server. Most installations will deploy client software to some or all of the end users of the system. Some
installations may not require deployment of the client software depending on how UC Server will be used.

4.2.3.1  Operating Systems
The client components of UC Server (UC Client and ucCompanion - Live Attendant) support the following
Microsoft® Windows™ Operating Systems:

e  Microsoft® Windows™ Vista, SP1 (Business, Ultimate or Enterprise Edition) (x86, x64)
e  Microsoft® Windows™ XP SP2, SP3 (Professional or Tablet PC Edition) (x86)

e  Microsoft® Windows™ Server 2008 (x86, x64)

e  Microsoft® Windows™ Server 2003 R2, SP2 (x86)

e  Microsoft® Windows™ Server 2003 SP1, SP2 (x86)

Other software platforms are not supported.

4.2.3.2 Hardware Requirements
To install UC client, the platform must meet the following minimum requirements for the specified Microsoft
Windows operating systems listed below.
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Client XP, Server 2003 Vista, Server 2008
Processor x86 compatible processor x86 or x64 compatible processor
600 MHz or higher 1GHz
RAM 256 MB 1GB
Free Disk space oo MB 5oo MB
Video Super VGA (800 x 600) or higher- Support for DirectX g graphics with:
resolution video adapter and monitor e \WDDM Driver
e Minimum 128 MB graphics
memory
o Pixel Shader 2.0 in hardware
® 32 bits per pixel

4.2.3.3 E-Mail Clients for Unified Messaging
UC Client integrates with the following e-mail clients for Unified Messaging:

e  Microsoft® Outlook™ 2000, 2002/XP, 2003 SP3, 2007
e |IBM® Lotus Notes™ 6.0x, 6.5.%, 7.0, 8.0
4.3 Product Licensing (License Key)

All UC Server product editions must be correctly licensed to enable the product to operate. The license key
obtained from Objectworld is specific to each installation and defines the exact functionality licensed by the end-
user for their installation.

4.3.1  Newlnstalls

When installing UC Server for the first time, you must obtain a License Key to install and activate the software.

4.3.2 Upgrades

To upgrade UC Server from a previous major or minor release, you must obtain a new License Key prior to
starting the upgrade. The existing License Key, found in the License Information dialog in the administrative UC
Client must be updated to the new License Key prior to starting the upgrade. After the new key is installed, you
may continue to upgrade the server software. You do not need a new license key for maintenance (patch or “dot")
releases.

Upgrade license keys are only available to customers who have an active Software Assurance subscription. Please
see section 6, Product Support.

4.3.3 Obtaining a New License Key

To obtain a new or upgrade license key, fill out a license key request in the support area of the Objectworld Web
site (http://www.objectworld.com/support).

Note: Please allow enough time to obtain the license key — at least one (1) business day should be allocated to
ensure the license key is obtained before installation or upgrade.

You will need the following information:

a. Contactinformation
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Product Keys
e New installs: available from materials that shipped with the product
o Upgrades: available for a user with Administrator privileges. From UC Client select the Help
menu > License Information.
Purchase Key
e New installs: available from materials that shipped with the product
e Upgrades — available:
e  Forauser with Administration privileges. From UC client select the Help menu > License
Information. Click Modify license.
e Viathe Product Licensing Wizard dialog of step 1 of UC Server Configuration Wizard
Machine ID
o New installs: available within the Product Licensing Wizard dialog of step 1 of the UC Server
Configuration Wizard
e Upgrades — available:
e  Forauser with Administration privileges. From UC client select the Help menu > License
Information. Click Modify license.

e Viathe Product Licensing Wizard dialog of step 1 of UC Server Configuration Wizard
Platform specifications: CPU speed, RAM and Server OS — available from the System control panel in
the Windows Control Panel.

Product version and edition you will be installing or upgrading to — available from the materials
shipped with the product

Message store type (Microsoft Exchange Server, Lotus Domino/Notes, IMAP4, or local machine) and
version

Legacy PBX interconnection, if applicable: PBX Type, Firmware version

4.4 Prerequisite Components

UC Server requires that prerequisite components be installed prior to installation of the UC Server software. The

installer will detect which components are missing from the system and prompt accordingly. Many of the

prerequisite components are included on the CD and can be installed automatically by the installer. However,

some have redistribution restrictions and must be obtained directly from the vendor. Links to the relevant web-

sites will be provided by the installer to any components that need downloading.

Not all prerequisites are required on all operating systems; specifics are noted below. Except where indicated, the

prerequisites are installed automatically by the installer. The prerequisite components are:

Microsoft Windows Server 2003 Service Pack 1 Administration Tools Pack (download link provided in
installer) [Windows XP only]

Microsoft .NET Framework 2.0 [Windows XP only]

Visual Studio 2005 SP1 Redistributable Files

Objectworld Software Logging Tools

Windows Server 2008 Enhanced Desktop Feature (a reboot is required after installation) [Windows
Server 2008-based systems only]

Microsoft SQL Server 2005 Express Edition (SP3 version is installed, older service packs are supported
except on some OS platforms)

WARNING: UC Server will only work correctly with the version of Microsoft
iy SQL Server that is provided on the distribution media. Other instances of SQL
Server cannot be used by UC Server.

£l
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5 Installation and Upgrade Instructions

Please review section 4, Installation Requirements, before proceeding with this section. It contains important
information about product licensing, system requirements, and the versions of external software components
that are required.

WARNING: Failure to comply with the installation requirements, or properly
% follow the installation or upgrade instructions will result in an inoperable or
poorly performing system.

-

5.1 New Install of UC Server

This section contains an overview of the installation for UC Server; for detailed installation procedures consult the
Install Guide. To facilitate installation and configuration, have the following reference material available during
installation (located on the distribution media):

e Release Notes (this document)

e Planning and Deployment Guide

e Install Guide

e UCServer Presence and Control Components Guide (for ucCompanion - Live Attendant)
e Configuration Guide

e Administrator Manual

To ensure that all the required information is available during the installation and configuration process, it is
recommended that customers fill in the Pre-Installation Checklist (located on the distribution media).

5.1.1 Installing the Server Software

The installation software will automatically verify the prerequisites for software installation. Make sure that you
run the installation from a Windows logon that has the ability to install software on the UC Server system (i.e.
Administrator privileges).

To install UC Server:

1. If the UC Server Software was downloaded from the Objectworld Web site follow step (a), if the UC Server
CD-ROM was shipped to you, go to step (b)

a. Unzip the contents of the file you downloaded to a temporary folder on UC Server (you will need to
provide a location and name for the folder). Start the installation by double clicking on
CAAutoRun.exe (the Objectworld Unified Communications Server CD Menu will appear).

b. Insertthe UC Server CD-ROM - the Auto run application will start and the UC Server installation
screen will appear.

2. Install the applications to the UC Server platform by clicking on the “Install Server” button on the installation
screen and following the prompts on the subsequent screens.

a. Ensure that all prerequisites are installed. These will vary depending upon your platform and the
components purchased, such as the Presence and Control components and the Windows 2003
Server Administration Tool Pack. The UC Server Installation Wizard will ensure that all prerequisite
components are installed before proceeding.

b. Afterall the prerequisite components are successfully installed, the wizard allows you to install the
UC Server software.

3. Runthe Server Configuration Wizard, “Configure UC Server”. The Server Configuration Wizard allows you to
specify server properties such as message store, UC Server administrator password, PBX information, and
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dialing properties. The wizard guides you through the Server configuration process. The wizard does most of
the configuration tasks automatically, however, site specific information about the network and server needs
to be entered at various steps.

4. When installing UC Server for the first time, you must obtain a License Key. To obtain a license key, please
refer to section 4.3, Product Licensing (License Key).

5.1.2 Installing the Client Software

In order for users of UC Server to take full advantage of its functionality, client software should be deployed to
their desktop or laptop computers. See section 5.3, Installing or Upgrading UC Client Software , for installation
options and procedures.

5.2 Upgrading/Cross-grading of UC Server

WARNING: Backup procedures have changed from previous releases. Please

review TNo66 - Backup and Restore Procedures and adjust backup
procedures accordingly. Failure to do so may result in data loss or extended
system outages in the case of hardware or software failures.

Ll

5.2.1  Upgrade/Cross-grade Matrix

The following table describes which versions of UC Server are upgradable to newer versions and which versions of
CallAttendant Office are cross-gradable to UC Server.

To 4.0.X 44X
(UC Server) (UC Server)
From
Pre 3.2.x (CallAttendant Office) unsupported via direct upgrade | unsupported via direct upgrade —
— upgrade to 3.2.x first, then to upgrade to 3.2.x first, then to
4.0.X 4.0.X
3.2.x (CallAttendant Office) J unsupported via direct upgrade —
upgrade to 4.0.x first

4.0.Xx (CallAttendant Office) v v
4.2.x (CallAttendant Office) v
4.0.x (UC Server) v
4.1.x (UC Server) v
4.2.x (UC Server) v
4.3.x (UC Server) v
4.4.X (UC Server) v

In order to upgrade from older versions, interim upgrade steps must be followed. Locate the correct section in this
below for more details.
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5.2.2  Upgrading UC Server from any 4.x.x Release

WARNING: The existing version of UC Server must NOT be un-installed prior
% toupgrading. The installation process requires that the existing
implementation be available in order to perform the upgrade correctly.

£l

The following is a summary of the upgrade procedure from any UC Server 4.x.x release; please consult the UC
Server Installation Guide for detailed instructions on installing this component.

WARNING: Failure to follow the steps below, exactly as described, may result
% in a system that does not upgrade or operate correctly after upgrade.

-

Perform the following steps:

1. If performing a major or minor upgrade, obtain a new license key. Please refer to the instructions in
section 4.3, Product Licensing (License Key).
2. Backup the UC Server using the instructions found in technical note TNo66 - Backup and Restore
Procedures to preserve the following data:
a) Users (greetings, services, announcements)
b) Port configuration
c¢) Attendantdata
d) System configuration
e) Routing data
f) Telephone data
g) Gateway data
h) PBXconfiguration data

WARNING: Failure to backup the data as per the instructions above and in the
4 Technical Note will result in the inability to restore the system to the original
system configuration should the upgrade process be unsuccessful or aborted.
Always backup the system prior to upgrading.

£l

3. Ifanewlicense key was obtained in step 1, modify the current license key using the following procedure:
a) Open UC Client using the current installed product version and log in as a user with
administrative privileges.

b) Select License Information... under the Help Menu on the main toolbar.
c) Click the Modify license... button to open the Modify License dialog box.
d) Enterthe new license key in the space provided.

e) Click OK to close the Modify License Dialog box.

f)  Click Close to close the License Information Dialog box.

) Close UC Client by clicking the top right corner “x” icon or selecting Close from the File menu.
4. Ifthe UC Server software was downloaded from the Objectworld Web site follow step (a), if the UC
Server CD-ROM was shipped to you, go to step (b)
a. Unzip the contents of the file you downloaded to a temporary folder on UC Server (you will need to
provide a location and name for the folder).
b. Insertthe UC Server CD-ROM. The CAAutoRun application will start and the “Objectworld Unified
Communications Server CD Menu” will appear — leave this open for now, you will use it later.
5. For SIP and CEBP editions, run the Pre-Update.bat script file as follows:
a) Click the Start menu and select Run...

[Ve]
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b) Type cmd.exe and click OK to open a command prompt window
c) Navigate to the script folder on the installation media using the cD command. This is located in
the Utility\Scripts subfolder of the installation media.

e.g.:CD /d C:\UCServerInstallMedia\Utility\Scripts

d) Runthe Pre-Update.bat script, supplying any appropriate parameters relevant to your
installation:

Syntax: Pre-Update.bat [/V | /?] [PhoneTypes Folder] [Backup Folder]

e Ifyour UC Server installation is not located at C: \Program
Files\Objectworld\UC Server), you must specify the location of the
PhoneTypes system data folder as shown below in the example.

e If backups should be written to a location other than
C:\Backup\PhoneTypes, then you must specify a backup folder as shown
below.

e The /2 Option provides help on the script; the /v option provides more
detailed output and logging.

e.g.: Pre-Update.bat “C:\Program Files\Objectworld\UC
Server\Data\System\PhoneTypes\” “C:\Backup\PhoneTypes\”

e) When the script prompts to continue, confirm the information displayed, and type Y, then press
Enter.
f)  Examine the output of the script to ensure it ran correctly. The output is placed a file called pre-
Log. txt in the backup location, which defaults to c: \Backup\PhoneTypes.
g) Leavethe command window open as it will be used later
6. The Application Services may be unable to be started during the upgrade due expiry of the service
account password. This can also occur spontaneously on some Windows XP installations or in networks
where account passwords have to be changed regularly, but will not be detected until the machine is
restarted or the Application Services are restarted. Be sure to have the service account password
accessible so as to be able to reset it immediately.
To verify that the service account password has not expired, do the following:
a) Open the Services administration tool from Start | Control Panel | Administrative Tools.
b) Locate the service named Objectworld UC Server Application Services.
c) Rightclick on the service, and select Restart from the context menu.
d) If the service fails to start, right click on the service, and select Properties from the content
menu.
e) Selectthe Log On tab. Re-enter the service account password in the provided fields and click
OK.
f)  Attempt to start the service again by right-clicking on the service, and selecting Start from the
context menu. If the service again fails to start, verify that the service account is operating
correctly and is not locked out.

Failure to perform this step will cause the install to fail with a 1920 error if there is a problem with the
service account or its password. This can be corrected by following the same steps while the 1920 error is
displayed. Do not cancel the 1920 error dialog as it will fail to upgrade and your system will have to be
restored from backups. When you have corrected the service account password, click Retry in the 1920
error dialog.

7. If the UC Server software was downloaded from the Objectworld Web site follow step (a), if the UC
Server CD-ROM was shipped to you, go to step (b)
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c. Locate the temporary folder where you extracted the files in a previous step. Start the upgrade by
double clicking on CAAutoRun.exe (the “Objectworld Unified Communications Server CD Menu”
will appear).

d. From the “Objectworld Unified Communications Server CD Menu"” will appear (opened when the CD
was inserted in a previous step), click the Install Server button to prepare the UC Server upgrade.

8. On anupgrade from previous releases, you may be required to install or update prerequisite
components. Click on the button “Verify or automatically install remaining components” button to
proceed. Some components may need to be downloaded from the vendor’s web sites.

9. Adding the Presence and Control Components:

a) Ifyou are using UC Server Standard Edition, or if you do not plan on using ucCompanion - Live
Attendant, then disable the following option:

"Install Presence Components to provide ucCompanion - Live Attendant client’s
connectivity to UC Server".
Click Next.

b) If you are upgrading the Presence and Control Components from a 4.2.X, 4.3.X OF 4.4.X version:

Click the Install Presence Components button in the "Preparing UC Server Installation"
dialog.

Click Install on the “Resuming the Objectworld UC Server Presence and Control
Components Setup Wizard” screen.

Click Finish when complete.

Click Yes when prompted to restart the system for the configuration changes to take effect.

c) If you are upgrading the Presence and Control Components from a 4.1 Trial version:

Click the Install Presence Components button in the "Preparing UC Server Installation"
dialog.

Click Next on the Welcome page of the "Objectworld UC Server Presence and Control
Components Setup" wizard and follow the prompts on subsequent screens until finished.
Consult the UC Server Presence and Control Components Guide for additional installation
documentation.

10. Upgrading the UC Server.
a) Ifupgrading from 4.2.%, 4.3.X Or 4.4.X:

The "Objectworld Unified Communications Server Setup" welcome page will appear briefly
as the upgrade does various checks on the system.

Click the Install button when the page titled "Resuming the Objectworld Unified
Communications Server Setup Wizard" appears and follow the prompts to complete the
upgrade.

Click the Finish button to close the setup wizard and return to the "Preparing UC Server
Installation" dialog.

b) If upgrading from 4.0.x or 4.1.x Trial:

Install the Server application to the UC Server platform by clicking on the Install UC Server
button.

The "Objectworld Unified Communications Server Setup" Welcome page will appear briefly
as the upgrade does various system checks.

Click the Install button when the page titled "Resuming the Objectworld Unified
Communications Server Setup Wizard” appears.

Continue clicking the prompts to complete the upgrade.

Click the Finish button to return to the “Preparing UC Server Installation” dialog.

11. Click the Configure UC Server button to launch the Server Configuration Wizard.

Note: If all the steps in the server configuration were completed prior to the upgrade, you will be

presented with three options (Change Service Account, add Users, specify Phone Types). You may be
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required to perform the first option, "Change Service Account” to reset the service account to what had
previously been configured prior to the upgrade.

12. In an upgrade from 4.0.x you need to complete Gateway configuration in the Server Configuration
Wizard then reset the service account:
a) Click onthe Configure UC Server to launch the "Server Configuration Wizard".
b) When prompted to login, login as a user with UC Server administrative privileges.
c) Complete the Gateways portion of the wizard. (Select Next, select None then Next, then click
Finish to close the Gateway wizard).
d) Click Exit to close the “Server Configuration Wizard".
e) Click the Configure UC Server button in the “Preparing UC Server Installation” dialog.
f)  Login as a user with UC Server administrative privileges when prompted.
g) Click onthe Change Service Account option and proceed to configure the service account.
h) Select the service account that was configured prior to the upgrade.
i) Click Close to exit the Server Configuration Wizard.
j)  Click Close to exit the “Preparing UC Server Installation.”
13. For SIP and CEBP editions, run the Post-Update.bat script file as follows:
a) Locate the command window opened in step 5
b) Run the Post-Update.bat script, supplying any appropriate parameters relevant to your
installation:

Syntax: Post-Update.bat [/V | /?] [PhoneTypes Folder] [Backup Folder]

e If your UC Server installation is not located at C: \Program
Files\Objectworld\UC Server), you must specify the location of the
PhoneTypes system data folder as shown below in the example.

o If backups were written to a location other than C:\Backup\PhoneTypes,
then you must specify the same backup folder as specified in step 5.

e The /2 Option provides help on the script; the /v option provides more
detailed output and logging.

e.g.: Post-Update.bat “C:\Program Files\Objectworld\UC
Server\Data\System\PhoneTypes\” “C:\Backup\PhoneTypes\”

¢) When the script prompts to continue, confirm the information displayed, and type Y, then press
Enter.

d) Examine the output of the script to ensure it ran correctly. The output is placed in a file called
Post-Log.txt in the backup location, which defaults to ¢: \Backup\PhoneTypes.

e) When the script completes, it will indicate if any site-specific customizations have been made.
Details of the customizations will be output to a file called FileComparison.txt inthe backup
location, which defaults to C: \Backup\PhoneTypes.

f)  Re-apply site-specific customizations to the relevant phone configuration files. Refer to phone
vendor documentation if needed. Once any customizations have been re-applied, restart the
Objectworld UC Server Application Services service using the Services administrative tool.

14. Update the RestartOverrides.cfg file (located in ..\UCServer\Data\System\Recovery\) according to
the following conditions:

a. If manual changes have been made to this file, then you must manually copy any entries from
RestartOverrides.cfg.original toRestartOverrides.cfgthatare not presentin the latter
file.

b. If no manual changes have been made to this file, then replace the contents of
RestartOverrides.cfg with the contents of RestartOverrides.cfg.original. Itis not
necessary to restart the ‘Objectworld UC Server Application Services’ service. However, if the file has
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been appended to instead of being replaced then the Application service must be restarted for the
changes to take effect.

15. If "Install Presence Components" was selected in step g, you will be required to configure these
components at this time. Please consult the "UC Server Presence and Control Components Guide” for
configuration documentation. If this is an upgrade from 4.2.x, 4.3.x Or 4.4.X, then the Presence and
Control Components may have already been configured.

16. For optimal performance, disable the Indexing Service provided by Windows. For detailed instructions,
please see section 3.7 Configuring Services of the Installation Guide.

17. For SIP and CEBP editions, re-apply phone configurations to all phones in the system as follows:

a) OpenUCClient and log in as a user with administrative privileges.

b) Click onthe Administration navigation bar.

c) Click onthe Phones folder in the Administration navigation bar.

d) Inthe contents pane, select all phones by clicking on the first phone, then pressing Shift-Ctrl-
End on the keyboard. All phones should now be selected.

e) Right-click on one of the selected phones, and select Reload Configuration from the menu. This
will cause all phone configuration files to be regenerated and phones to reload their
configuration data (rebooting most phone types).

5.2.3  Cross-grading from CallAttendant Office Server 4.0.x/4.2.x to UC Server (all editions)

WARNING: The existing version of CallAttendant Office must NOT be
uninstalled prior to cross-grading. The installation process requires that the
existing implementation be available in order to perform the upgrade
correctly.

o

The following is a summary of the procedure for cross-grading your CallAttendant Office release 4.0.x/4.2.x
software, please consult the UC Server Installation Guide for detailed instructions on installing the UC Server
component. If the CallAttendant Office software is currently below the 4.0 Software versions, you must first
upgrade to Release 4.0.x version.

This upgrade will take significantly longer as the UC Server installation program will make a complete copy of the
data for the upgraded installation. For large installations where voice and fax messages are stored on locally, it
can take 1-2 hours to copy the data during the upgrade. Do not cancel the upgrade during this process. As a result,
this upgrade will require at least twice as much disk space as the Data folder occupies in order to perform the
upgrade.

Prior to upgrading to Release 4.0.x do the following:

1. Backup the CallAttendant Office using the instructions found in technical note TNo71 — Backup and
Restore Procedures for CallAttendant Office to preserve the following data:

a. Users (greetings, services, d. System configuration
announcements) e. Routing data

b. Port configuration f. Telephone data
Attendant data g. Gateway data

WARNING: Failure to backup the data as per the instructions above and in the
Technical Note will result in the inability to restore the system to the original
system configuration should the upgrade process be unsuccessful or aborted.
ALWAYS backup the system prior to upgrading.

--—
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2. Record the CallAttendant Office service account username and password. This can be done using the
Services Control Panel application. Select the CallAttendant Office service and record the username. The
password must already be known as it cannot be viewed in the Services Control Panel.

3. You must have an up-to-date license key to support the latest release of CallAttendant Office 4.0.x and
UC Server (in some circumstances, you may receive two (2) license keys that will be used to support the
upgrade). To obtain a new license key, please refer section 4.3.3, Obtaining a New License Key.

4. Ensure that you enter the new license key in the CallAttendant Office administrator application (Help >
License Information) menu prior to upgrading the software.

WARNING: If an existing PBX is being replaced with UC Server PBX, please
contact support@objectworld.com for additional instructions.

Ll

To install UC Server:

1. Rename all of the configuration files in the . \Data\System by appending". 01d" to the existing
filename :

e.g.C:\Program Files\Objectworld\CallAttendant Office
Server\Data\System\DefinityPBXDefinition.cfgtoDefinityPBXDefinition.cfg.old

2. Ifthe UC Server software was downloaded from the Objectworld Web site follow step (a), if the UC

Server CD-ROM was shipped to you, go to step (b)

a. Unzip the contents of the file you downloaded to a temporary folder on UC Server (you will need to
provide a location and name for the folder). Start the installation by double clicking on
CAAutoRun.exe (the UC Server installation screen will appear). Preserve a copy of the installation
media accordingly. See section 4.1, Preserving Installation and Upgrade Media.

b. Insertthe UC Server CD-ROM - the Auto run application will start and the UC Server installation
screen will appear.

If you plan on using ucCompanion — Live Attendant, install or update the UC Server Presence and Control

components at this time. Consult the UC Server Presence and Control Components Guide for

installation documentation, which is provided on the distribution media.

4. Install the Server applications to the UC Server platform by clicking on the Install UC Server buttons on
the UC Server installation screen and following the prompts on the subsequent screens until finished.

5. Foroptimal performance, disable the Indexing Service provided by Windows. For detailed instructions,
please see section 3.7 Configuring Services of the Installation Guide.

6. Once the installation has completed, select the “Configure UC Server” button to run the Server
Configuration Wizard but do not add anything if it has already been configured. From the set of options,
at a minimum, complete the following tasks:

a. Enterthe UC Server License key to enable SIP functionality
b. Configure the "Windows Network Integration” and select from one of the following:
i. If the service account was previously configured for “Local System” account, you must create a
Windows account on the local machine. Operating the “Application Services” service on the
“Local System” account is no longer supported.
ii. If the service account was previously configured with a Windows Active Directory™ account,
then configure the “Existing Service Account.”

7. Open the Windows Services application and ensure that the Objectworld UC Server Application
Services is set to start automatically. Note, you may have to refresh (Fs) the Services application in order
to get a current view of the status. From the Windows Services applications, start the Objectworld UC
Server Application Services if it is not already started.

w
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Complete the remaining steps in the Server Configuration Wizard. If appropriate add any additional
configuration changes required such as adding UC Server as a new communication system, adding new
phone types or new gateways.

Cross-grading from CallAttendant Office Server 3.2.x to UC Server (all editions)

Note: It is not possible to upgrade directly from 3.x to 4.2 and later releases (see section 5.2.1, Upgrade/Cross-

grade Matrix). An upgrade from CallAttendant Office 3.x to CallAttendant Office 4.0.x must be performed as an

intermediate step. Once this is completed, an upgrade to the latest UC Server 4.x release can be completed.

To upgrade 3.x to 4.0.x:

1.

~

Backup the CallAttendant Office using the instructions found in technical note TNo71 — Backup and
Restore Procedures for CallAttendant Office to preserve the following data:

a. Users (greetings, services, d. System configuration
announcements) e. Routing data
b. Port configuration f. Telephone data
Attendant data g. Gateway data
WARNING: Failure to backup the data as per the instructions above and in the
! Technical Note will result in the inability to restore the system to the original

system configuration should the upgrade process be unsuccessful or aborted.
ALWAYS backup the system prior to upgrading.

Stop the CallAttendant Office Service from the Windows Services application.

Rename the following files:

a. C:\Program Files\Objectworld\CallAttendant Office
Server\Data\System\Announcements folder to Announcements.old

b. C:\Program Files\Objectworld\CallAttendant Office
Server\Data\System\DefinityPBXDefinition.cfgtoDefinityPBXDefinition.cfg.old

C.

If the CallAttendant Office software was downloaded from the Objectworld Web site follow step (a), if

the CallAttendant Office CD-ROM was shipped to you, go to step (b)

a. Unzip the contents of the file you downloaded to a temporary folder on the CallAttendant Office
server (you can create a CallAttendant Office folder). Start the installation by double clicking on
CAAutoRun.exe (the CallAttendant Office installation screen will appear). Preserve a copy of the
installation media accordingly. See section 4.1, Preserving Installation and Upgrade Media.

b. Insert the CallAttendant Office CD-ROM - the Auto run application will start and the CallAttendant
Office installation screen will appear.

Install the Server applications to the CallAttendant Office platform by clicking on the Install

CallAttendant Office Server buttons on the CallAttendant Office installation screen and following the

prompts on the subsequent screens until finished. Do not choose to reboot the computer at this point.

Open the Windows Services application and set the CallAttendant Office Service to start

automatically. Note: you may have to refresh (F5) the Services application in order to get a current view

of the status.

From the Windows Services applications, start the CallAttendant Office service.

Convert the system audio. If the software was upgraded from Release 3.1 or earlier, you must convert

the audio from the pre-existing 11 kHz-8bit audio format to the newly supported 8 kHz mu-law audio.

Although the CallAttendant Office server will change the audio format “on-the-fly” the conversion will

introduce latency in playing audio files or messages.
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To perform the audio conversion:

a.

Caution: Ensure that you perform this conversion during the maintenance window — typically after
normal business hours.

From My Computer, navigate to the C: \Program Files\Objectworld\CallAttendant
Office Server\Bin directory

Double-click on the ConvertAudio.exe application.

Upgrading Client Software

If anything other than a minor server upgrade has taken place, client software will also need to be updated on end

user computers; only 4.4.x client software is supported with 4.4.x server software. See section 5.3, Installing or

Upgrading UC Client Software , for installation options and procedures.

53

Installing or Upgrading UC Client Software

This section documents manual installation procedures, and presents other techniques for automated client

deployment.

5.3.1

WARNING: Only release 4.4.x UC Client software is compatible with UC Server

4.4.x software (the patch revision value 'x’ does not need to be identical). All
incompatible clients must be upgraded after the UC Server has been
upgraded.

Ll

Manual Installation or Upgrade Instructions

Note: The user installing UC Client software MUST have administrative privileges on that desktop computer.

1.

If the UC Server software was downloaded from the Objectworld Web site follow step (a), if the UC Server
CD-ROM was shipped to you, go to step (b)

a.

Unzip the contents of the file you downloaded to a temporary folder on UC Server (you will need to
provide a location and name for the folder). Start the installation by double clicking on
CAAutoRun.exe (the Objectworld Unified Communications Server CD Menu will appear). Preserve a
copy of the installation media accordingly. See section 4.1, Preserving Installation and Upgrade
Media.

Insert the UC Server CD-ROM - the Auto run application will start and the UC Server installation
screen will appear.

Install the client applications to a client computer by clicking on the “Install Client” button on the installation
screen and following the prompts on the subsequent screens.

a.

If a minor UC Client upgrade is being performed, click on the Install button to begin the upgrade and
continue to follow the prompts on the subsequent screens until finished.

If a major UC Client upgrade is being performed, click Next on the Welcome page of the
“Objectworld Unified Communications Setup”.

Installing UC Client directly on the UC Server platform is not supported.
Ensure that the client is installed on a separate platform meeting the

Ll

minimum requirements (see section o, Objectworld now recommends the use
of Microsoft Exchange Server MAPI Client and Collaboration Data Objects
1.2.1 instead of Microsoft Outlook and strongly encourages all customers to
switch to this MAPI connector instead of Outlook. The benefits of doing this
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are as follows:

e No Outlook license is required for the UC Server system. The
MAPI/CDO package is available at no charge.

e The MAPI/CDO package is a minimal installation that requires fewer
Microsoft Updates.

e This component is designed and provided by Microsoft explicitly for
the purpose of allowing applications such as UC Server to access
Exchange Server and does not include many of the client-side
nuances of Outlook versions of MAPI.

On Exchange Server 2003, additional steps are required after following the
manual integration instructions in Appendix A of the Server Configuration
Guide:

Delegate “Exchange View Only Administrators” control to the UC Server
service account:

12. Open Exchange System Manager on an Exchange Server in the
enterprise, or an administrative workstation.

13. Select the enterprise level object (the root object in the tree).

14. Select Delegate control... from the Action menu. This will open the
Exchange Administration Delegation Wizard.

15. Click Next.

16. Inthe Users or Groups page of the wizard, click Add to open the
Delegate Control dialog.

17. Select the role Exchange View Only Administrators from the list of roles.

18. Click Browse... and select the service account used by UC Server for
Exchange Server and network integration.

19. Click OKin the Select Users, Computers or Groups dialog.

20. Click OK in the Delegate Control dialog.

21. Click Next in the Users or Groups page of the Exchange Administration
Delegation Wizard.

22. Click Finish to complete and close the wizard.

WARNING: Client Components).

5.3.2  Other Techniques for Installing and Upgrading Client Software
Client software may be deployed using automated techniques including:

e GPO-based MSl installation. See TNo34 - Client Software Installation Guide for more information on
this option.

e  GPO-based login scripts that invoke either SETUP.EXE or MSIEXEC . EXE with appropriate parameters.
Prerequisites components may already need to have been successfully installed. Consult standard
Microsoft documentation for more information on those techniques.
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6 Product Support

For information on available support programs, policies and procedures for obtaining technical support, please
visit: http://www.objectworld.com/support/. Please be sure to have read and understood the Objectworld Services

Program prior to engaging Objectworld Support Services.
End users and untrained professionals have the following options for obtaining technical support with UC Server:

e Contact the reseller who sold or installed your solution (a support agreement with your reseller may be
required).

e Visit the Objectworld web site for self-help material: http://www.objectworld.com/support/

e Contact Objectworld Technical Support (Service Vouchers are required). Visit the Objectworld web site
for more information: http://www.objectworld.com/support/

e Contact Objectworld Professional Services to contract installation, upgrade or other services:
proservices@objectworld.com or call 1 (888) 398-9698 or +1 (613) 599-9698

Objectworld Technical Professionals have the following options for obtaining technical support with UC Server:

e Visit the Objectworld web site for self-help material: http://www.objectworld.com/support/

e Contact Objectworld Technical Support (a Software Assurance subscription is required or Service
Vouchers will be required). Visit the Objectworld web site for more information:
http://www.objectworld.com/support/

e Contact Objectworld Professional Services to contract installation, upgrade or other services:
proservices@objectworld.com or call 1 (888) 398-9698 or +1 (613) 599-9698

To purchase Service Vouchers, you have the following options:

e Contact the reseller who sold or installed your solution.
e  Purchase online from the Objectworld web site. See http://www.objectworld.com/support/ for more
information.

To obtain a Software Assurance Subscription, you have the following options:

e Contact the reseller who sold or installed your solution.
e Contact the Objectworld Sales Department: sales@objectworld.com or 1(888)398-9698 or +1 (613)
599-9698

7 Documentation and Training

7.1 Product Documentation

Detailed product documentation is included on the distribution media. These are located in the \Docs folder of
the distribution media. Documentation is provided for installers, administrator and end users. The following types
of documents are included:

e Release Notes (this document)

e Planning, Deployment, Installation, Configuration, Administration and User Guides
e Technical and Application Notes

e  Third Party Integration Guides

e SIP Telephone User Guides

e Training materials
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7.1.1  Technical and Application Notes

Detailed technical notes about UC Server and integration with third-party products are included on the
distribution media. There are located in the \Docs\TechnicalNotes folder of the distribution media. The
following types of technical and application notes are included:

e Backup and Restore

e PBXintegration

e giiandEnhanced 911

e Lotus Notes/Domino integration

e SIP Gateway configuration (including sample configuration files)

e Troubleshooting

e Out-dialing application notes and example automation/database application

e  SIPtrunking

e List of products certified under the Objectworld Connect™ Plus Interoperability Programs and the
Objectworld Interoperable™ Program.

e Additional phone configuration for SIP phones that are not Objectworld Connect™ Plus products

e Paging deployment

e Callrecording

7.1.2  Training Course Materials

The UC Server distribution media now includes the technical training course handout from our leader-led course,
aimed at professional IT administrators and technicians.

The media also includes training for end users. There are several Flash-based, self-study training modules, and a
printable course handout that a user of our system can go through at their own pace to learn how to get the most
from their UC Server system.

These can be found in the \Docs\TechnicalTraining andinthe \Docs\EndUserTraining folders of the
distribution media respectively.

Additional training material is also provided in the support area of our web site:
http://www.objectworld.com/support/.

7.2 Training

Objectworld offers training for qualified professional IT administrators and technicians. This course is provided at
Objectworld’s corporate location in Ottawa, Canada. Contact the Objectworld Sales Department at
sales@objectworld.com or 1 (888) 398-9698 or +1 (613) 599-9698 to enroll. With successful completion of this

training, participants are granted an Objectworld Technical Professional designation.

Objectworld also offers end-user training through its professional services group. Contact Objectworld
Professional Services at proservices@objectworld.com or call 1 (888) 398-9698 or +1 (613) 599-9698.

Information on current training programs and materials can be found in the support area of the Objectworld web
site: http://www.objectworld.com/support/.

7.3 Product Downloads and Third Party Drivers

Product downloads and third party drivers and patches are available in the support area of the Objectworld web

site: http://www.objectworld.com/support/. A user id and password are required to access this material.
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8 Third-party Interoperability

WARNING: At this point in time, many third-party drivers and applications DO

NOT support Windows Server 2008 and derived platforms. When using TAPI
integrations, or other integrations requiring the use of CTI drivers, please
review driver documentation for those products BEFORE proceeding with
plans to use Windows Server 2008 as the server platform for those
deployments.

Ll

8.1 UC Server with a PBX Integration (Hybrid Configuration)

8.1.1  Supported Private Branch Exchanges (PBX)

UC Server has the native capability to connect to multiple traditional PBXs and IP PBXs while simultaneously
supporting SIP services (SIP Edition only). UC Server can be deployed as a voicemail, unified message server,
database IVR platform and fax server behind a traditional PBX while also simultaneously supporting SIP
Telephony (SIP Edition only). This provides a useful transition strategy for companies looking to migrate to VolP
but who still want to leverage their existing infrastructure. UC Server users that employ a traditional PBX for
telephony can still take advantage of Active Directory™ integration for user management; the telephony features
will be managed through their PBX configuration interface.

UC Server integrates with a wide variety of traditional PBX and IP PBXs using Dialogic 1000 and 2000 Media
Gateways. The following PBXs are now supported using the Dialogic Media Gateway:

e Alcatel Omni PCX 4400 e Nortel CS-1000

e Avaya Communications Manager e Nortel DMS 10

e Avaya Definity G3 e Nortel DMS 100

e Avayalegend e Nortel Meridian1

e Avaya Merlin Magix e  Phillips Sopho

e Avaya Partner e Rolm (Siemens) 8ooo
e  Ericsson BusinessPhone e Rolm (Siemens) gooo
e Ericsson MD1a1o e Rolm (Siemens) 9751
e Intecom PointSpan M688o e Siemens HiCom 150E
e Mitel 3300 e Siemens HiCom 300
e Mitel SX-2000 e Siemens HiPath 4000
e Mitel SX-200D Family e Toshiba CTX

e NECNEAX2400
For more details on specifically which PBX editions and interfaces are supported, please consult the Dialogic
Media Gateway documentation available from Dialogic’s web site:
http://www.dialogic.com/support/helpweb/mg/integration.htm.
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UC Server also integrates with the PBXs listed in the table below using one of the following techniques:

e Analog port integration with in-band tones using Dialogic® D/4PCIUF and D/120JST-LS Media Boards
¢ Digital set emulation using Dialogic® D/82JCT-U and D/42JCT-U PBX Integration Boards

e (Tllink/analog port integration using Dialogic® D/4PCIUF and D/120JST-LS Media Boards

e PBXVendor supplied Microsoft TAPI/WAVE Service Providers

PBX Vendor/Model | Minimum Technical Note Integration Type 3rd Party
Software (TN) Reference Hardware/Software
Release Number (Recommended)
Avaya 1.0 and above TNo16 Digital set emulation: Dialogic 6.0 SU 229
Communications - 7434D emulation
Manager - 8434D emulation
- 7434ND emulation
Avaya Definity 6.3 and above TNoog Analog port using mode | Dialogic 6.0 SU 229
(no CLID) codes; Mode code
option is required
Avaya 4 and above TNo1o Digital set emulation: Dialogic 6.0 SU 229
Definity/Multi- - 7434D emulation
Vantage - 8434D emulation
(with CLID) -7434ND (7.5 and above)
Avaya IP Office 2.0 and above TNo12 CTl link/analog port - IP 400 CTl link
using TAPI - IP 400 TAPI-WAVE
Dialogic 6.0 SU 229
Avaya Merlin 3.1and above Analog port using mode | Dialogic 6.0 SU 229
Legend codes
Avaya Merlin Magix | 2.1and above TNoo8 Analog port using mode | Magix CTl link bundle
(with CLID) codes Dialogic 6.0 SU 229
Avaya Merlin Magix | 2.1and above TNoo8 CTl link/analog port Dialogic 6.0 SU 229
(no CLID) using mode codes
JTSAPI
Avaya Partner ACS 3.0 and above Analog port using mode | Dialogic 6.0 SU 229
codes
Cisco Call Manager 4.2 TNo39 Cisco-supplied Microsoft
TAPI/WAVE Service
Provider
Mitel SX200 (family) | Gioo5/LW16 TNo11 Analog port using Dialogic 6.0 SU 229
F41.0.2 enhanced in-band DTMF

tones
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PBX Vendor/Model | Minimum Technical Note Integration Type 3rd Party
Software (TN) Reference Hardware/Software
Release Number (Recommended)
Mitel 3300 (IVR only) | Any version Analog port using in- Dialogic 6.0 SU 229
that requires band DTMF tones
ONS voicemail
support
Nortel Norstar 4.2 and above TNoo3 Digital set emulation: Dialogic 5.1.1 with

- M7324 set emulation

PTR.31016 **

Generic in-band

PBX dependent

Analog port using in-
band DTMF tones

Dialogic 6.0 SU 229

** UC Server ONLY supports Dialogic Release 5.1.1 software with PTR.31016 (LIBFAXMT.DLL) for Norstar PBX's
as the Do Not Disturb feature does not work with Dialogic Release 6.0 for Nortel Norstar PBX.

8.1.2

To install Dialogic software (available on the distribution media) on the new UC Server:

1. Install the Dialogic System Software compatible with the PBX make and model.

New Installation of Dialogic Software

a. Run SETUP.EXE from Windows Explorer.
i. When prompted to select features, select "Core Runtime Package"; select Next.

ii. When advised that the installation will install third party software, select Yes. The installation

will detect and remove any existing Dialogic system software.

iii. The first stage of the installation will require a reboot. When prompted to restart the system,

select Yes.

2. Verify through the Windows Hardware Device Manager that all of the Dialogic cards reside in the

"Dialogic Springware Devices section".

Note: If any of your cards appear to be improperly configured (i.e. Caution symbol or otherwise) then you

will have to update the driver
a. Toupdate the driver:

i. Locate and configure the Dialogic card from Device Manager.

ii. Select Driver tab and select "Update Driver".

iii. Choose the "Search for suitable driver for my device (recommended)" and click Next.
iv.  Thedriver update will locate the Dialogic Card; click Next.
b. Repeat steps i through iv for each Dialogic card that appears improperly installed or configured.
3. Run Dialogic Configuration Manager (Start > Programs > Dialogic System Release > Configuration
Manager — DCM. DCM will detect any Dialogic hardware installed on the machine hosting UC Server

software.

a. Ensure that the board settings match your PBX type. (The default configuration is Nortel Norstar.)
b. Fordigital set emulation, open each card and ensure the MISC tab > PBXSwitch parameter is
configured according to your integration.
c. Seethe relevant configuration guide
4. Configure the Dialogic service to start automatically; Select Settings > System Device Autostart to "Start
System". Itis normal to encounter the error message "Failed to set the Device Autostart setting.
Requested data not found in NCM data storage."
5. Proceed with UC Server installation instructions.

36

Objectworld Communications Corp. * 308 Legget Drive * Ottawa, ON ¢ Canada * K2K 1Y6 ¢ T: 613-599-9698 ¢ F: 613-599-7457 * www.objectworld.com




Objectworld

6. Verify the Dialogic board ordering by running UC Client as an administrator and call each port. If the
ports are not answering in the correct order, switch the Dialogic cables on the back of the machine
hosting UC Server software.

8.1.3 Toupgrade Dialogic software on existing UC Server (if required)

Once you have determined that the Dialogic software version needs to be upgraded then perform the
following steps:

1. Remove existing Dialogic system software.
a. Stop the existing UC Server and Dialogic services
b. Launch the Microsoft® Windows Service control application (Start > Settings > Control Panel >
Administrative Tools > Services)
i. Stop the service labeled "UC Server” and change the service Startup type from Automatic to
manual.
ii. Stop the service labeled “Dialogic System Service”
c. Remove Dialogic System Software
i. Locate the Add/Remove Programs from the Windows Control Panel. (Start > Settings > Control
Panel > Add/Remove programs)
ii. Select and Remove the Dialogic software.
d. Reboot the system as indicated
2. Note: Inrare instances you may need to run an Dialogic utility to clean up the old Dialogic Release 5.1.1
installation files, directories and registry settings. This batch file can be located in
\cleanup\dlgc rel clean.bat inthe Dialogicinstallation directory. This will be apparent if the
Dialogic DCM - configuration management application is not installed.
3. Install the Dialogic System Software.
a. Follow the procedure in the section above (New Installation of Dialogic) to install the required
version of Dialogic applicable to your PBX.

8.2 Gateway Interoperability

UC Server has the native capability to connect to multiple gateways to provide access between the customer’s
network and other service providers using either analog or digital trunk connections. Please see technical note
TNos1- UC Server Interoperable SIP Devices and Services — for complete feature compatibility.

8.2.1  Analog Gateways

UC Server integrates with the following analog gateways:

Vendor Partner Level Model Software Release
Mediatrix Connect 1204 5.0.15.92

Quintum Connect Tenor AS, AF P104-12-17
Vegastream Connect 50 6x4 11.02.07.5R0755009

8.2.2  Digital Gateways

UC Server integrates with the following digital gateways:

Vendor Partner Level Model Software Release
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Vendor Partner Level Model Software Release
AudioCodes Connect Mz1oo0 4.80A.033.004
Quintum Connect Tenor DX P104-12-17
Vegastream Connect 400 10.02.07.25R0725018

8.3 SIP Firewall / SIP ALG Interoperability

UC Server has the native capability to interoperate with a third-party firewall for IP address translation on the SIP
Services between the customer’s network and other service providers. Please see technical note TNog1 — UC
Server Objectworld Interoperable SIP Devices and Services — for complete feature compatibility.

UC Server integrates with the following SIP Firewalls:

Vendor Partner Level Model Software Version
Edgewater Interoperable 4200, 4300, 5300, 5300LF, 6400, 6400LF Series | 6.7.4
Ingate Connect Firewalls: 1190, 1500, 1550, 1590, 1900 4.6.1
SlIParators: 19, 50, 59, 90 4.6.1
Intertex Interoperable IX66, IX67, IX68 4.02

8.4 ITSP Interoperability

UC Server has the native capability to connect to multiple Internet Telephony Service Providers (ITSP). ITSPs are
used to provide access between the customer’s network and other service providers using SIP trunking. Please see

technical note TNogs1 — UC Server Interoperable SIP Devices and Services — for complete feature compatibility.

Note: ITSP interconnections are only supported via an Ingate Firewall and SIParator, seeTNogs5 — Objectworld

ITSP Configuration — for more information.

Provider Partner Level Services

AGN Interoperable Inbound DID Calling, 8oo Inbound Calling, 911 and Eg11, Incoming Caller ID

babyTEL Interoperable Inbound DID Calling, Incoming Caller ID

BandTel Connect Inbound DID Calling, 8oo Inbound Calling, 911 and Eg911, Incoming Caller ID

Bandwidth Connect Inbound DID Calling, 800 Inbound Calling, 911 and E911, ENUM Number
Delivery, Incoming Caller ID

Broadvox Connect Inbound DID Calling, 800 Inbound Calling, Incoming Caller ID

Clarity Voice Interoperable Inbound DID Calling, 800 Inbound Calling, 911 and Eg11, Incoming Caller ID

VocalNet Connect Inbound DID Calling, 8oo Inbound Calling, 911 and Eg11, Incoming Caller ID
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8.5 Telephone Terminal Interoperability

The following telephone terminal hardware and software are supported. Before selecting and purchasing
telephone terminal devices, please consult technical note TNoga— UC Server Interoperable SIP Devices and
Services for complete feature descriptions of each device and for complete compatibility information.

Vendor Partner Level Model Software Version
Aastra Connect+ 9112i, 9133i, 480i, 480iCT 1.4.3
6751i, 6753i, 6755i, 6757i 2.4.1
Cisco Interoperable 7940, 7960 P0OS3-08-8-00
7912 8.0.1 (060412A)
Grandstream Connect BT101, BT102 1.1.0.3
Connect+ BT200, BT201 1.1.6.16
GXP 280 1.1.6.27
GXP1200, GXP2000, GXP2010, 1.1.6.16
GXP2020
GXV3000 1.0.1.27
Linksys Interoperable SPAg41 5.1.8
Mitel Interoperable 5220, 5224, 5235, 5330, 5340 R7.0.01.01.01.09
Polycom Connect+ SoundPoint IP 320, 330, 430, 450, | 3.1.0.0084°

501, 550, 560, 601, 650, 670

SoundStation 4000, 6000, 7000 3.1.0.0084
VVX 1500 3.1.2.0750

snom Connect+ 300, 320, 360, 370 7.3.143
820 8.1.3

8.6 Softphone Interoperability

The following softphones are supported. Please see technical note TNog1— Objectworld Interoperable SIP
Devices and Services — for complete feature compatibility.

Vendor Partner Level Model Software Version
CounterPath | Connect eyebeam 1.5.5
X-lite 3.0.41150

* Older model Polycom sets, including the Polycom SoundPoint IP 301, are no longer supported with this version
of the firmware.
3 Upgrades from V3,4, 5, (to V7) require a special upgrade path: http://wiki.snom.com/Firmware/V7/Update
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Vendor Partner Level

Model

Software Version

SJLabs Interoperable

SJphone

1.65.377a

8.7 SIP Wireless Servers

The following wireless servers are supported. Please see technical note TNos1— Objectworld Interoperable SIP

Devices and Services — for complete feature compatibility.

Vendor Partner Level Model Software Version
Polycom Connect Kirk Wireless Server KWS300 PCSo3A

Kirk Wireless Server KWS600v3 PCSosAc

Kirk Wireless Server KWS6000 PCSo3A

8.8 SIP Paging Speakers, Controllers, Amplifiers and Intercoms

The following paging speakers, controllers, amplifiers and intercoms are supported. Please see technical note
TNos1- Objectworld Interoperable SIP Devices and Services — for complete feature compatibility.

Vendor Partner Level Model Software Version

CyberData Connect VolIP Speaker 4.0.2
VolP Paging Server 1.12
VolIP Zone Controller 1.06
VolP Paging Amplifier 3.02
VolIP Loudspeaker Amplifier 3.02
VolP Intercom 2.04

Atlas Sound | Connect+ VolIP Speakers I8S, I85C, I8SCM, IHVP | E286p54
and 1128SYS
VolP Zone Controllers IPS-ZC1 and E286p54
IPS-ZC2

8.9 Software Product Interoperability

The following other software products have been tested and are known to work with UC Server:

Vendor

Partner Level

Product/Service

Software Version

Research In Motion

Interoperable

BlackBerry Enterprise Server

4.1 0r newer

(RIM) for Microsoft Exchange
BlackBerry Handheld Devices 4.2.1rev 163, 4.2.2 Or newer
PhoneTag Interoperable PhoneTag n/a

(formerly SimulScribe)
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Vendor

Partner Level Product/Service

Software Version

Google

Interoperable Google Mail (Gmail)

using stunnel (SSL proxy)

n/a
stunnel 4.24

9 Known Software Limitations

The following limitations are known in this UC Server release:

Tracking #

ISSUE

Workaround

4325

Silent Installation of ucCompanion — Live
Attendant (installation fails using command line
with parameters: /S [v/qgn)

Use Install Wizard

4503

UC Server implementations on a Microsoft
Windows Small Business Server (SBS) will not be
able to view voice or fax messages from the local
machine or through the terminal services client
connected to the same Small Business Server. The
Microsoft MAPI version that is installed with
Microsoft Exchange Server does not support the
same capabilities as the MAPI driver that is
installed with Microsoft Outlook. Installing Outlook
on the SBS server will not resolve this issue, nor is it
supported by Microsoft.

Please contact the Objectworld
Communications Technical Support
department if this is critical to your
deployment or demonstration scenario.
Note that this is not a supported deployment
scenario.

4614

There is currently a known issue with the Windows
Installer on Windows Vista platforms. During
uninstall of UC Server, the “User Account Control”
dialog indicates that the publisher is ‘unidentified’.
This issue is caused when the Windows Installer
caches a copy of the MSI package in the Installer
folder during the installation process. Windows
Installer removes some data from the cached copy
of the MSlI in an effort to reduce the size consumed
by the copied MSI. As a result, the embedded
digital signature becomes invalid.

Accept the warning and continue

5020

Call Swap on ucCompanion — Live Attendant is not
supported

None

5124

On Windows Vista, the Objectworld fax printer
driver will not successfully execute if UC Client is
installed by either the administrator or by a user
that has used the "Run as administrator” option.
Note that this scenario does not apply to a user
installing UC Client that has elevated their
privileges to administrator to install UC Client.

In both cases, after installing UC Client it will
be necessary to log out and log back in to
Windows (as the appropriate user).
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Tracking # ISSUE Workaround

5204 On Windows Vista, The Objectworld fax printer The first time that UC Client is run it must be
driver will not successfully execute if UC Client is launched from the Start Menu.
first launched directly from Outlook or by running
the executable directly from the “bin” folder.

5571 Three-way conference initiators do not pass DTMF  Have the conference initiator generate the
tones generated by conference participants. DTMF tones.

5742 Windows services automatic recovery processes Ensure the recovery settings for the UC
hinder diagnosis of any startup issue and could Server Application Services service are set to
result in unnecessary entries added to the system ~ “Take no Action” in all cases (First failure,
or application event logs. Second failure, and subsequent failures).

These settings should not be changed.

5859 Minor non-compliance related to Request URIl in None
ACK and BYE SIP Messages under very specific
circumstances involving specialized equipment.

SIP, CEBP

5862 Incorrect call status displayed on ucCompanion — Restart the Objectworld UC Server SIM
Live Attendant Ul occurs infrequently and then service in the Services control panel.
usually only on low end or overloaded systems and
immediately after an installation.

5878 Windows XP and Windows Server 2003 system Turn off the Indexing service. See the UC
performance — Indexing service uses large amount ~ Server installation manual for instructions.
of page file space (larger than 1.2 GB) and CPU
time

5966 Creating a UC user from within Active Directory, it  The administrator can explicitly set the PIN
is possible to neglect creating an associated from within the AD pages.
identity at the same time. This has the side effect
of not creating a temporary PIN for the user.

6073 Service account password is not preserved on The upgrade instructions included in this
upgrade from 4.0.x to 4.2.x if the “current account” document describe the necessary steps to
option is selected in the Select Service Account restore the service account. Please ensure
dialog. This specifies that the currently configured  you follow these instructions.
service is to be used as the service login account. If
selected, then the UC Server Application Service
will fail to restart.

6256 On an upgrade from pre 4.2.1, the ucCompanion—  The Calls menu shortcut assignments are

Live Attendant “Calls” menu does not
automatically use the new shortcuts as described in

the documentation. |SIP, CEBP|

customizable, so to preserve these custom
settings, the new shortcut mappings are not
automatically registered. To manually reset
the shortcuts to the new mappings perform
the following action: Within the View menu
select Toolbars >, then Customize.... In the
Customize dialog box, select the Keyboard
tab then click the Reset All button.
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Tracking # ISSUE Workaround

6614 In some cases, caller information may not be None.
received in distributed IP Office TAPI integrations.

6797 Uninstalling UC Server from Windows Server 2008  After uninstalling UC Server, manually stop
does not automatically stop the OBJECTWORLD the OBJECTWORLD SQL Server Express
instance of SQL Server. service, and then manually uninstall the

OBJECTWORLD SQL Server Express
instance.

6978 After upgrade to Windows Vista Service Pack 1, UC  Reinstalling the Microsoft's Windows Server
Server MMC plug-in is no longer available. Administration Tools will resolve the
Reinstalling UC Client does not resolve the problem.
problem.

7074 Fax printer driver cannot send faxes when My This appears to be an issue with the
Documents folder is redirected to network share. Microsoft Universal Printer driver supplied in

Windows Vista and used by the Objectworld
Fax Printer Driver. Workaround is to disable
My Documents redirection.

7376 Sending faxes to the Fax Printer Driver in A4 Print using Letter format instead.
format causes the fax document to be generated
incorrectly and the fax will fail to be sent.

7700 AMD systems running Windows Server 2003 or Follow instructions in Microsoft KB article
Windows XP may experience choppy or corrupt 895980:
audio with some phones. |SIP, CEBP| http://support.microsoft.com/kb/895980

8149 Active Message Delivery may fail when all ports on  Increase the number of ports to improve port
an Avaya IP Office are busy. availability.

8282 On Windows XP, the service account used for the Use Windows Server-based platforms instead
Application Services may spontaneously become of Windows XP. Additional instructions have
lost or invalid. This can occur when the system is been added to upgrade procedure to
restarted, the Application Services are restarted, or mitigate the 1920 problem during upgrade
UC Server is upgraded (causing a 1920 error). caused by this issue.

8374 snom phones do not register on networks with

spanning tree enabled. Consult snom support
material for more details.

Enable fast spanning tree or disable spanning
tree on the network. Consult snom support
material for more details.
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